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About this Addendum

This addendum provides the latest and complete print head maintenance and job
workflow information for optimal job setup and print head performance on the Baltoro
press.
Read the workflow overview and follow these procedures when printing at the start and
the end of your shift, and when performing routines dC0141 and dC0965.
This information supersedes or enhances information in the following topics in the
customer documentation:
•

Use a Warmup Sheet in Your Job

•

Enable Runtime Monitoring

•

Set the Print Head Routine Shift Reminder

•

Daily Print Head Maintenance and Workflow

•

Automatic Print Head Purge

•

Run dC0141 Print Head Setup

•

Run dC0965 Print Head Maintenance
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1.

Overview of Job Workflow with Print Head
Maintenance and Missing Jet Detection
The basic overview of your job production workflow on the Baltoro press begins with
ensuring that the print heads are at optimal performance. To assist you in visually
assessing the state of the print heads regarding registration and color uniformity, the
system provides image quality test patterns, PrintHeadReg 50 and PrintHeadReg24.

At the Start of the Day
If you left the press powered on, the press is in sleep mode. Sleep mode removes power
to the print heads after the press is idle for 60 minutes. This mode protects the print heads
from drying out while keeping the rest of the system powered on for a faster cycle up.
1. Check that the print engine is powered on:
a. If needed, power up and start the press. The press interface displays a splash
screen.
b. If the press is powered on but in sleep mode, clear the status message. The press
exits sleep mode automatically.
Caution: Do not open dC0965 to perform a manual purge since this will reset the
timer. Manual purges are not recommended after the press has been inactive for a
long time.
The press begins to warm up and returns power to the print heads.
2. At the press interface:
a. Click the print engine icon in the message area or select Menu > Options >
Switches to open the Switch Settings dialog. Enable the recommended job setup
features: Runtime Monitoring and Cycle Up Settings. Also, access the Stock
Library Stock Settings dialog and set the stock to use as cleanup sheets. For these
procedures, go to Recommended Feature Settings for Job Setup.
b. Refer to the Active Status message area for when the press is ready to print and
other operator instructions.
3. At the press, perform any maintenance tasks needed. Also, make sure the inkjet
treated paper stock you are using for your job is loaded on the press.
4. At the print server, locate and print the PrintHeadReg50.pdf file:
a. Click the Print From File shortcut. The Print From File window appears.
b. Use the drop-down menu near the Browse button to select the location of the file.
Navigate to and select PrintHeadReg50.pdf. Select OK.
c. Set the quantity to 20.
d. From the Paper Stock tab, select the inkjet treated stock you are using for your
print production job.
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e. From the Color Management tab, make sure the following is selected: Inkjet
Treated stock, Medium Drop size, and Direct CMYK for Images, Text, and
Graphics. From the Image Edit tab, be sure X and Y offset are set to 0.00: Y:
0.00, X: 0.00.
Caution: If the offset values are not set to 0.00, the stitch zone markers are not
aligned to the actual stitch zone.
f.

Select the PRINT queue. Click the Print button to release and print 20 copies of
the test pattern.

Note: When printed, all image quality corrections are applied. If the press has been
idle 8 hours, the press may perform two automatic purges and wipes.
Figure 1: PrintHeadReg50.pdf (area coverage of 50% with Med Drop Size)

Stitch Zone –
designates where
two print heads
overlap jetting
Check that there are no
defects under the trapezoid
marks for each color

Note: To view how a customer job may print with missing jet correction working, you
cannot use test prints from dC0106, Runtime Monitoring, dC0965, or Warmup Sheet
and Missing Jet Update. These prints have missing jet correction turned off and the
press does not apply missing jet correction or density optimization.
Note: To help you identify the cause of a defect, look at the width of the streak— the
wider streaks are most likely Density Optimization issues, where thinner white ones
are usually missing jets.
5. Evaluate all 20 sheets for variations:
a. Look for IOP issues by checking for white space on all edges of the test
pattern. If there is no white space on any edge, run the dC0610 routine to
correct IOP misregistration.
b. Then, assess color-to-color registration:
• Look at the registration targets at the bottom of the page. If you notice the
colors do not line on top of each other, run the dC0141 routine with Print
Head Alignment phase selected.
• Look at the halftones for white streaks and nonuniformities. If you observe
light and dark streaks in the stitch zone area on the test pattern, run
dC0141 to align print head registration. Refer to How to Run the dC0141
Routine.
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c. Next, look for uncorrected missing jets. If you observe white lines in the
process direction on the sheets, run dC0965 to perform a manual purge. To
perform dC0965, go to How to Run the dC0965 Routine.
d. If you continue to notice nonuniformities in the halftone area, run dC0141 with
the Density Optimization phase selected. The Density Optimization feature
corrects for inboard to outboard color non-uniformities.
6. When there are no issues with registration, alignment and nonuniformities, you are
ready for print production.
Note: Save daily samples of these test patterns. Use the prints to assess the
current system state and help you understand if print head performance is
degrading over time and other corrections needed. Write the date on the test
pattern. There are many patterns to choose from, and they can be selected from
cycle up prints or analyses after auto or manual purging.
7. Print your job.

At the End of Each Shift or End of the Day
Note: If you did not create and enable the shift reminder from the Switch Settings dialog,
a shift reminder message does not appear.
1. Complete printing all jobs.
2. When a shift reminder message appears, select Go To Print Head Maintenance.
Otherwise, at the press interface side bar, select Diagnostics and P1 > dC0965 Print
Head Maintenance. The maintenance screen appears.
3. From the Select Phase menu, select End of Shift.
4. From Purge Type, keep Standard Purge selected.
5. Under Head Capping, keep Cap Heads selected.
6. Purge all print heads. Click the Select All button.
7. Click Start.
The routine performs a purge, wipe, and analyze sequence and a long-term blade
cleaning for all print heads. These actions prevent the print heads from drying during
idle time, moisten the wiper blades, and help maintain the cleaning stations.
8. To exit Diagnostics mode, select File > Exit Diagnostics.
Note: If you keep the press powered on at the end of the day, the press enters a sleep
mode. The system removes power to the print heads so the ink remains in a good state.

How the Press Manages Missing Jets on Print Heads
Each factory-built print head can have up to 30 permanently missing inkjets. The algorithm
used by the press for missing jet detection sufficiently compensates for these missing
inkjets and additional jets that accumulate over time. Missing jet correction adequately
hides isolated missing jets in most jobs.
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The purge feature on the press is designed to recover missing jets, which helps to prevent
image quality defects. While purging recovers most missing jets, note that some image
quality defects are not caused by missing jets. These types of issues can be resolved by
running dC0141 that aligns print heads or updates density optimization.

Automatic Print Head Purges
The system performs automatic purges at predefined intervals to prevent the ink from
drying on the print heads. The automatic purges prevent most missing jet faults and
are effective at minimizing the need for manual purges.
Note: For the press to monitor and update the missing inkjet list after an automatic
purge, enable the cycle up and runtime monitoring features. Refer to Recommended
Feature Settings for Job Setup.
The automatic purge intervals are:
• If a purge did not occur in the last 8 hours, the system performs a double purge the
next time the press cycles up to print a job.
• If the system has not printed a job in the last hour, the system performs a single
purge the next time the press cycles up to print a job.
• If the system did not purge in the last 2 hours, the system performs a single purge
that interrupts printing. Then, printing resumes automatically.

Manual Print Head Purges
Manual purges are initiated through the Print Head Maintenance dC0965 routine.
Perform a manual purge under the following situations only, as they prevent the
system from performing automatic double purges when needed.
Perform a manual purge:
• When notified by dC0141 or the missing jet popup message.
• If you observe a white streak on your output and have determined it is due to
missing jets.
• Before switching to a job requiring wider paper.
Note: When performing purges, always select the Purge, Wipe and Analyze phase
along with the Standard Purge Type and Cap Heads.
Do not run dC0965 to perform a manual purge:
•

At the start of the day when the press has been idle for an extended time. When
the press cycles up after being inactive overnight or after an 8-hour shift, the
system performs a double purge automatically. If you perform a manual purge at
the start of the day, before printing your job, the press resets the timer and a
double purge is not performed when needed.

•

If print heads remain checked after a purge, which indicates that missing jets
remain, but no missing jet faults display, do not perform a second purge or multiple
consecutive purges. Typically, jets that do not clear with one purge do not clear
with additional purges immediately afterwards. It is more effective to allow time
and print volume to occur between purges.
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How the Press Alerts you to Missing Jets and What to Do
Note: If you want to run jobs with productivity in mind over high image quality, contact a
service representative who can adjust settings on the press. While the threshold default is
100 missing jets per print head, always be aware of what your actual threshold setting is
currently.
When printing and the press detects that the number of missing jets on a single print bar
exceeds the threshold, a warning message appears. From the top tray, look for the last
runtime test pattern measured. This sheet shows the threshold exceeded results.
If the XPE-15-240x fault log appears, refer to the log only fault for the missing jet count
listed in the variable data section. Do the following:
1. Retrieve the print and estimate how many missing jets are visible on the printout:
a. Occasionally an IOP or IOI problem, or a glob of ink on the print, is causing image
analysis to think there are a lot of missing jets, when there is not. If this appears to
be the situation, check that the:
•

Image is in the correct location on the page (IOP) with a 2mm border on both
IB and OB sides.

•

Print heads are in the right location with respect to each other. Inspect dashes
at head boundaries to be sure no dashes are overlapping or severely
misregistered.

•

Paper is white and shows no visible defects.

• Image is not smudged or contaminated with ink.
b. If a high number of missing jets are visible, you should select the recommended
option from the message to run the dC0965 routine and perform maintenance on
the print bar.
c. When the reported number of missing jets is much higher, 500 or greater, than
what is visually seen on the test pattern, this could indicate an image analysis
issue. Do not perform a manual purge. Inspect the test pattern sent to the purge
tray and:
1) If there is not at least a 2 mm white space between the dashes and the edge of
the sheet, at both the IB and OB sides, run dC0610 Image on Paper Setup.
2) If you observe dashes in the runtime /warmup missing jet test pattern, that are
not well-aligned in the print head stitch zone, run the dC0141 Head Angle and
Alignment phase. This phase corrects the head-to-head registration. Refer to
How to Run dC0141 Print Head Setup.
3) Make sure that the Integrated Imaging Module (IIM) is properly docked to the
Marker Transport.
d. If there are no problems with the print causing the image analysis to identify
missing jets not there, and the count remains over the threshold, call for service.
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2. From the warning message, select one of the following options:
•

•

Reset - Select if the print quality is acceptable. This option allows you to continue
printing without running the print head maintenance routine. The next
measurement in which missing jets exceed the threshold will cause the message
to re-appear.
Dismiss for This Shift – The system will no longer display this fault for that
specific print head for the remainder of the current shift. However, the press will
raise a fault for other print heads. For this feature to work, shift times must be set
in the Shift Reminder dialog.
Note: This option can lead to unacceptable print quality later in the shift with no
warning.

•

Go to Print Head Maintenance – The system closes the fault dialog and opens
the dC0965 Print Head Maintenance screen. Purge all print heads using the
manual process and then restart the job.
Note: Do not repeatedly run dC0965 in attempts to get all print heads below 50
missing jets. Repeated purge cycles are not effective. Alternating purge cycles
with print volume and rest periods are more successful in restoring stubborn jets.
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2.

Recommended Feature Settings for Job Setup

Refer to Prepare Files for Printing in the Customer Documentation. Then, use the
following to learn more recent information about these job features.
At the press interface, to ensure that the press detects the fixable missing inkjets and
corrects them as they occur, access the Switch Settings dialog and enable the following
features.

Set the Job to Use a Warmup Sheet and Perform Missing
Jet Update
Note: You can use a warmup sheet in a job with custom profiling. The warmup sheets and
missing jet test patterns do not interfere with the ILS detecting the custom profiles.
1. Open the Switch Settings dialog.
2. From the Cycle Up Setting area, select Warmup Sheet and Missing Jet Update.
When you select either Warmup Sheet or Warmup Sheet and Missing Jet Update,
for every production job, the press prints a warm up sheet at the start of the job to
exercise the inkjet nozzles.
If you specified Warmup and Missing Jet Update, in addition to the warm up sheet,
the press prints and analyzes test patterns to identify missing jets and update the
missing inkjet list. The missing jet correction resulting from the analysis takes affect
within the first 5-10 customer prints.
Missing Jet correction and Density Optimization are not applied to any warm up
sheets or test patterns. Large numbers of missing jets on the test patterns are normal,
especially in magenta. Also, density variations across the page are expected.
Note: Do not use these sheets to try to identify missing jets or evaluate print head
performance.

Set the Job for Runtime Monitoring
Use this feature to correct print head registration and automatically check for missing
inkjets during printing. The press pauses printing when the number of missing jets on a
single print head exceeds the set threshold.
1. From the Runtime Monitoring area in the Switch Settings dialog, select the Missing
Jets check box. Throughout the job run, the press checks for missing jets and updates
the missing inkjet list.
3. For the press to correct slow drifts in registration, select the Head Registration check
box.
4. At the Impressions Interval menu, use the default and recommended setting of 250.
This is the number of 8.5-inch equivalent sheets in your job that print before the
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runtime missing jet test pattern prints automatically to the purge tray. This cleanup
sheet is used to determine the state of missing jets.
Using a runtime sheet wider than the print job does not prevent edge jets from being
identified as missing and from faults occurring.

Select the Cleanup Stock
From the Stock Library, set the type and size of stock to use for the test pattern cleanup
sheets. For the best performance, the stock you select for cleanup, which is used for the
warmup and runtime analysis sheets, needs to be the same width as the production job.
•
•

If the cleanup stock is narrower, not every in-use jet can be evaluated for being
missing.
If the cleanup sheet is wider, the magenta edge jets will go missing within a short
period of time, leading to unnecessary missing jet faults. The image content of any
runtime job printed on that sheet is cropped on the inboard side to match the width of
the next sheet printed in the customer job.

1. Make sure you have a stock loaded for cleanup (or purge) sheets.
2. From the Stock Settings dialog, select the Cleanup check box to define the test
pattern as a cleanup sheet. This ensures the press sends the test pattern to the top
tray of the stacker.
3. For Type, select plain paper or the stock you use for your print job. Do not load or use
any of the following as a cleanup sheet:
•
•
•

Gloss paper - The high levels of ink can cause ink contamination within the system
Coated stock - This will ensure that coated papers are not used for runtime
monitoring or warmup sheets.
Pre-printed, drilled, or colored stock

Set the Print Head Routine Shift Reminder
Enable the Shift Reminder feature to display a message automatically, just before your
shift ends, reminding you to perform the Print Head Maintenance routine. The popup
message allows you to access the dC0965 routine directly.
Make sure to set at least one shift reminder. This feature works best if shifts are
designated as 8 hours.
1. From the Administration screen, select the Shift Reminder tab.
2. Select the Show Reminder check box and define the shift time and day. You can
select a shift time that overlaps another shift reminder setting.
A notification message will display at the designated time.
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3.

Daily Print Head Maintenance Routines
How to Run dC0141 Print Head Setup
The dC0141 routine positions the print heads and adjusts color-to-color registration. The
Head Angle and Position Alignment phase aligns the print heads relative to each other,
within color and from color-to-color, as well as measure and correct for missing jets. The
Density Optimization phase minimizes cross-process direction non-uniformities within
each color.
Note: Make sure the setting Optimize for Color Rendering from the Switches Settings
dialog is selected.
Note: Since no corrections are applied to these prints, density variations across the page
are expected in the warmup sheets and the analytical test patterns printed during dC0141.
1. From the press interface side bar, select Diagnostics to enter Intrusive Diagnostics.
2. Select P1 > dC0141 Print Head Setup. The diagnostic screen appears.
3. Select Print Options.
4.

From the Print Options dialog, select the widest paper size available, at least as wide
as the customer job. Refer to the following for acceptable paper sizes to use with this
routine.
•
•
•
•
•
•
•
•

US Legal 216 x 356 mm (8.5 x 14 in.) LEF
B4 250 x 353 mm (9.84 x 13.9 in.) LEF
A4 210 x 297 mm (8.27 x 11.69 in.) LEF
US Letter 216 x 279 mm (8.5 x 11 in.) LEF
SRA3 320 x 450 mm (12.6 x 17.7 in.) SEF
Arch B 305 x 457 mm (12 x 18 in.) SEF
A3 297 x 420 mm (11.69 x 16.54 in.) SEF
US Tabloid 279 x 432 mm (11 x 17 in.) SEF

Note: If you use any other paper sizes or orientation, you may experience image
analysis faults when running dC0141.
Note: If you are printing in black only mode, the press prints the black only version of
the test pattern.
Important: It is recommended that you do not use drilled, colored, or pre-printed
stock. The preprinted forms and drilled stock may cause sensor faults, while colored
stock can interfere with identifying missing jets on the test patterns.
5. Select N-1 for paper order, and Purge Tray for the output destination. To close the
Print Options dialog, click X.
6. Select the appropriate phase check boxes:
a. Since the Warming phase occurs automatically when you select either one of the
other two phases, you do not need to select this check box.
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b. If you observe color-to-color, or within color, misalignment on your output, select
the Head Angle and Position Alignment check box.
c. To correct the inboard-to-outboard color density variations, select the Ink Density
Optimization check box.
Note: When you select this check box, it is recommended that you also select the
Head Angle and Position Alignment check box. Always perform Image alignment
along with the Ink Density Optimization phase.
7. From the Print Head Setup screen, select Start. The routine initiates the following
phases in sequence: Warming, Image Alignment/Registration, and Ink Density
Optimization. A progress bar shows the status of the routine overall and the status of
each phase.
When the Warming phase completes, and the Head Angle and Position Alignment
phase begins, the press prints and analyzes the registration and missing jet test
patterns. The press adjusts the head alignment, if needed, and reprints the test
patterns. This process repeats until all registration measurements are within the range
required for the print heads or the maximum number of attempts is reached. If the
head registration converges, but some print heads still have missing jets that exceed
the threshold, the phase completes successfully.
When the Ink Density Optimization phase begins, the press prints a few warm-up
sheets and 8 test patterns, 2 for each color. The system automatically prints,
evaluates the sheets, and applies corrections to every print. The process repeats as
needed to optimize the density uniformity.
After all phases complete successfully, the progress bar shows 100% and the Start
button is green.
8. To view the results of the analysis after each iteration of the alignment phase, which
includes the number of missing jets being reported, select View Data. A separate
screen opens listing the following data for each color and print head.
• Current and maximum number of iterations of the Print Head Setup routine
• Time and date of the data currently shown
• Current roll error value
• Current X direction registration error value
• Current Y direction registration error value
• Current number of missing inkjets
Use the measurement data to compare whether it exceeds or meets the tolerance
threshold parameters for optimal registration. If one or more values exceed the
threshold, a warning icon appears.
Print heads whose values exceed the threshold for Roll, X-error, Y-Error and number
of missing jets are marked with a yellow triangle. Use the marks to track progress at
each iteration and identify failed elements. This phase can still pass even if missing
jets exceed the threshold.
9. If any phase of the setup routine fails, deselect the completed check boxes and restart
dC0141.
10. When the routine completes successfully, go to the stacker and retrieve the last sheet
printed during the Alignment phase.
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11. Visually inspect all output for missing or stray jets and for print head alignment results.
Inspect the Density Optimization test patterns for overall color uniformity.
Note: Missing jet correction is not applied to the Analytic test pattern that is printed
after the Print Head registration sheets, which allows you to view the number of inkjets
actually missing in the system.
12. To apply missing inkjet correction and see if the results are enough for your job,
submit a few pages from the print server.
13. When finished running this routine, select X to close the screen.
14. Select File > Exit Diagnostics to exit Intrusive Diagnostics.
If the dC0141 routine does not complete successfully, check the last 200 faults in the
Administration Call for Assistance screen. If the routine stopped, an Image Analysis
fault, XPE-15-2280, appears. From the Active Status List screen, check for other faults
listed that precede XPE-15-2280 and resolve those faults first. To open the recovery
dialog for instructions, double click on the fault. Then, view the variable data for fault
XPE-15-2280 to identify the cause, and resolve. In the Active Status List screen,
highlight the faults, right click, and select Reset. Rerun the dC0141 routine.
Note: After completing the dC0141 routine, the image-on-paper registration
measurement may have moved. If needed, run the dC0610 IOP routine to adjust the
IOP registration.

How to Run dC0965 Print Head Maintenance
When the press indicates that a manual purge is needed, run the dC0965 routine. Always
use the Purge, Wipe, and Analyze option. The routine purges and wipes the
recommended print heads and flushes the wiper blades. It also checks for missing inkjets
and updates the missing inkjet list. After the routine completes, the screen displays the
status of the print heads and applies a correction to upcoming prints.
1. Make sure the appropriate stock is loaded in the feeder tray and use a stock that is at
least the same width as the job.
2. When a job is not printing, select dC0965 Print Head Maintenance at the left of the
press interface, beneath the side bar.
3. The Print Head Maintenance screen appears and shows the three print heads for
each color. A check displays in the check box for each print head that the system
recommends purging. A wrench icon shows next to the check box.
Note: For the following features, do not select any other phase unless directed to do
so by Service.
4. From the Select Phase menu, for purging, always select Purge, Wipe and Analyze.
5. From Purge Type menu, leave the default selection to Standard Purge. Never select
the Short Fill Manifold Purge option.
6. For the Head Capping option, leave the default selection to Cap Heads.
7. To display the number of missing jets in each print head after the system performs an
analysis, select Show Missing jets check box. When the Show Missing Jets check
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box is enabled on screen dC0965, the threshold is 50 missing jets, which is much
lower than the threshold that creates a warning message.
Caution: Data numbers shown from the Show Missing Jets feature are out of date and
inaccurate until a purge, wipe and analyze task is performed.
Note: Show Missing Jets is informational only. If the press encounters more than 50
missing jets, a yellow triangle on screen dC0965 indicates that the missing jets exceed
the set threshold. The number of missing jets that cause a print head to be
recommended for maintenance (checked) is much lower than the number of missing
jets expected to correlate to a visual defect in the print.
The press provides extra cleaning for print heads above the typical levels, so a second
purge is not needed. A single purge is recommended but not required. If heads remain
checked after the purge, yet no fault is declared, do not repeatedly purge in attempts
to lower these numbers. It is acceptable to have more than 50 missing jets.
9. After a single purge, continue printing and check the output. Missing jet correction
adequately compensates for nearly all missing jets when under the fault threshold.
Some missing jets that do not clear with a purge will clear in time or printed ink
throughput. If there are no issues with the output, ignore any missing jet numbers over
50.
10. Under Print Heads, select the Select Recommended button. The system determines
which print heads are recommended for purging and displays a check mark next to
them.
11. If you see one or two print heads selected for any given color, but not all three, click
on the check boxes not selected to select them all. If you are concerned about ink
usage, use the check boxes to select individual print heads for each print bar only.
Note: For optimal image quality, make sure to select all print heads in a print bar when
at least one head of that print bar is selected for purging.
12. Select Start at the bottom of the screen. The system purges and wipes the selected
print heads, checks for missing inkjets, and updates the missing inkjet list. The system
checks each phase at the top of the screen as it completes and prints the test patterns
used for the Analyze portion of the routine. The prints show missing jets for either 4
color mode or K only mode.
Note: If the analyze portion of DC965 fails for any reason, do not repeat the purge.
The analysis, done as part of cycle up, accomplishes the same goal of updating the
missing jet list.
When the phase completes, a Standby status appears. The press print operation
returns to a ready-to-print state. If print head cleaning is still in progress, the press
does not cycle up for printing until all print heads are in a safe position.
If any phase such as wiping, cleaning, or capping did not complete, the system
displays a message to run Cleanup for Exit. Perform this action. Then, close and exit.
13. After you complete the dC0965 routine, select File > Exit Diagnostics to close the
routine and exit Diagnostics.
Note: If you leave the routine open, the press is unable to perform blade cleaning as
needed.
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4.
•

Troubleshooting: Missing InkJet Faults

XPE-09-5005: Missing Jet State Unknown
The routine did not complete missing jet analysis. This message informs you that
there is no missing jet list to measure against and no current count available.
Refer to the information on the message. If the issue does not resolve, contact
Service.

•

XPE-15-240x: Color Station X Too Many Missing Jets
This log only fault message is raised when the number of missing jets in an individual
print head exceed the set threshold. The missing jet count is listed in the variable data.
When this fault appears too frequently and image quality is acceptable, contact your
Service Representative to modify the system to meet your production needs.

•

XPE-03-6017: MIOP to IBC Communication Fault
This fault appears if you restart the press from the Applications menu on the CentOS
title bar. To avoid this fault message, always select Menu > System > Restart from
the press interface screen.

•

XPE-10-4106: Paper Under Temperature Faults
This fault can occur when printing jobs continuously with papers of differing weights,
such as printing a lightweight runtime sheet in a job using heavyweight stock.
To avoid these faults, print runtime sheets on the same paper as the job, if possible.
Otherwise, set the weight of the warmup sheet and runtime missing jet sheets in the
range of the heavyweight paper. For example, if the warmup and runtime sheets are
90 gsm and the stock for the job is 250 gsm, you can program the lightweight stock as
150-200 gsm. This keeps the dryer temperature set point in an allowable range.

•

XPE-15-xxxx: Hard Ink Limit Exceeded Fault
This fault appears when Large and Max Drop sizes are used with Optimize for Speed
mode on any stocks, no matter what the coating. If used, the hard ink limit for the print
engine software will be exceeded and a fault displays .
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